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USER GUIDE

Introduction

This user guide describes how to get started with the Atmel® ATmega328P
Xplained Mini board. The ATmega328P Xplained Mini evaluation kit is a
hardware platform to evaluate the Atmel ATmega328P microcontroller. The
evaluation kit comes with a fully integrated debugger that provides seamless
integration with Atmel Studio 6.2 (and later version). The kit provides access
to the features of the ATmega328P enabling easy integration of the device in
a custom design.
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Getting Started

1.1. Features
The ATmega328P Xplained Mini evaluation board provides a development platform for the Atmel
ATmega328P.
Key Features
*  On-board debugger with full source-level debugging support in Atmel Studio
*  Auto-ID for board identification in Atmel Studio
*  Access to all signals on target MCU
*  One green mEDBG status LED
*  One yellow user LED
*  One mechanical user push button
*  Virtual COM port (CDC)
«  External target CLK 16MHz at 5V, 8MHz at 3.3V
« USB powered
*  3.3Vregulator
*  Arduino shield compatible foot prints
*  Target ISP bus header foot print
«  Xplained Pro extension headers can easily be strapped in
1.2. Design Documentation and Related Links
The most relevant documents and software for the evaluation board are available here:
Design Documentation - A .zip file containing CAD source, schematics, BOM, assembly drawings, 3D
plots, layer plots, etc.
Atmel Studio - Free Atmel IDE for development of C/C++ and assembler code for Atmel microcontrollers.
Xplained - Atmel Xplained prototyping and evaluation platform.
Atmel Spaces - Open Source projects for Xplained Mini.
1.3. Xplained Mini Quick Start
How to connect the ATmega328P Xplained Mini board embedded debugger to Atmel Studio and how to
connect the ATmega328P UART to a COM port.
1.3.1. Connect to Atmel Studio
How to connect the ATmega328P Xplained Mini board embedded debugger to Atmel Studio to get started
with SW development.
1. Download and install Atmel Studio version 6.2 or later versions.
2. Launch Atmel Studio.
3. Connect the board to the USB port and it will be visible in Atmel Studio.
1.3.2. Connect to the COM Port
How to connect the ATmega328P UART to a COM port.
AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 3
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All Xplained Mini boards have an embedded debugger (mMEBDG) with a number of features, among them
a CDC/COM port, which enables the user to connect the ATmega328P UART to the PC.

1. Connect the Xplained Mini USB to the PC.
2. A COM port named "mEDBG Virtual COM Port" will be available.

3. Start a terminal emulator or other applications using the COM port, typical COM port settings are
9600 baud N81.

1.4. Programming and Debugging
Programming and debugging the ATmega328P Xplained Mini.
The target microcontroller is the ATmega328P.
The mEDBG FW is running on the ATmega32U4.
1.4.1. Programming the Target Using mEDBG
Using the Embedded Debugger on the ATmega328P Xplained Mini board to program the ATmega328P.
1. Connect the Xplained Mini USB to the PC.
2. Go to Atmel Studio: click the Tools tab, select Device Programming, and select the connected
mEDBG as Tool with Device as ATmega328P and Interface to ISP, click Apply.
3. Select "Memories" and locate the source .hex or .elf file and click Program.
mEDEG (ATML2323040200013430) @ Bulcn&ngmmmmg’_L F d_m |
u Tool Device Interface Device signature Target Voltage |
| [mEDBG v | ATmega3z8p  + 5B |l Apply| OaEs0F [Read| 50V |Reas| (3|
— | i =
Device information Flash (32 KB}
Oscillator Calibrat CAUsersitb I\ Documentsisvn\ATmega328P_Xplained_Min\07_FimwarerevDl_verification ~ | =
R R R [ rogan | [ vey_| [ i
Lock bits EEPROM (1 KB)
Preduction file =
7 Verfy EEPROM after programming Read.. |
i
P o
Vernifying Flash...0K
{=] Verifying Fiash..0K
Close
4. NOTE: If a previous debug session was not closed by selecting "Disable debugWIRE and Close" in
the Debug menu, the DWEN fuse will be enabled and the target will still be in debug mode, i.e. it
will not be possible to program the target using the ISP.
=]
5. If the source file contains fuse settings, select "Production file" and upload the .elf file to program
the fuses.
AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 4
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6.

1.4.2. Debugging the Target Using mEDBG

Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program". Recommended
fuse settings:

@D 5UT CHSEL | EXTCLK BCK 14CK B3MS = |

mEDBG [ATML23; 30} @ - Devi Tl- - -__Tl i _li =‘ ﬁ P &w
” Tool Device Interface Device signature Target Voltage '
—— Y S | [P [ Pamd | Bead | 1%
| | mEDBG = | ATmegaizsp » |BR = ||Apply|  DAESOF | Read S0V Read ;§|
Interface settings Fuse Name Value
| 1 ]
Tool information A BODLEVEL |1VB v
(& RSTDISBL
Device information
 DWEN
Oscillator Calibration 2
@ sPEn i
Memories
= & WDTON
luses
1) EESAVE
M Lock bits T
@eooTsz | 256W.3600 * |
Preduction file @ BOOTRST |
@ cxoive
1 crout

Fuse Register  Value
EXTENDED  OuFE =
HIGH OxDF
| Low 0xED
| Copyto clipboard |
o] Auto raad
¥ Verify after programming | Program || Venfy || Read
| = | Verify registers ..OK
Close

Using the Embedded Debugger on the ATmega328P Xplained Mini board to debug the ATmega328P via

debugWIRE.
1. Start Atmel Studio.
2. Connect the Xplained Mini USB to the PC.
3. Open your project.
4,

i

Click the "Project" tab and select the project "properties”, click the "Tools" tab and select mMEDBG

as debugger and debugWIRE as interface.
Click the "Debug" tab and select "Start Debugging and Break".

Atmel Studio will display an error message if the DWEN fuse in the ATmega328P is not enabled,

click YES to make Studio set the fuse using the ISP interface.
(" Launch Faifed ' l ==

% Failed to launch debug session with debugWIRE. This could be caused by reset line
circuitry or dizabled debugWIRE interface. Make sure that the reset line is free before
continuing. Do you want to use 5P] to enable the DWEN fuse?

——

s [ T

7. A debug session is started with a break in main, debugging can start.
8. When exiting debug mode select "Disable debugWIRE and Close" in the Debug tab, this will

disable the DWEN fuse.

Important: If not exiting debug mode by selecting "Disable debugWIRE and Close" in the
Debug menu, the DWEN fuse will be enabled and the target will still be in debug mode, i.e. it

will not be possible to program the target using ISP.

Atmel
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1.4.3.

1.4.4.

Atmel

Important:
debugWIRE is not guaranteed to work.

Important: Applying a signal to J202/RESET (the RESET_SENSE signal) while debugging
may result in unexpected behavior. This signal is NOT available during a debugging session

If any other CPU CLK than the external CLK supplied by the mEDBG is used the

because the RESET line is actively used by the debugWIRE interface

Programming the Target Using an External Programmer

How to program the target ATmega328P using the AVR® JTAGICE mkll, JTAGICE3, Atmel-ICE, or other

Atmel Programmers.

1. Connect the External Programmer USB to the PC.

2. Connect the External Programmer to the ATmega328P Xplained Mini board ISP connector.
3. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the External

Programmer connected as Tool with Device as ATmega328P and Interface to ISP, click Apply.

4. Select "Memories" and locate the source .hex or .elf file and click Program.

Programming the ATmega32U4 Using an External Programmer

How to program the ATmega32U4 using the AVR JTAGICE mkll, JTAGICE3, Atmel-ICE, or other Atmel

Programmers.

1. Connect the External Programmer USB to the PC.

2. Connect the External Programmer to the ATmega328P Xplained Mini board JTAG connector.

3. Go to Atmel Studio: click the Tools tab, select Device Programming, and select the connected

mEDBG as Tool with Device as ATmega32U4 and Interface to JTAG, click Apply.
4. Select "Memories" and locate the source .hex or .elf file and click Program.

At izt 120 6 _Beves e S
Tool Device Interface: Device signature Target Voltage
| Atmel-ICE | ATmega32ud Read | i3|

~ 117G = |[Apply] = | Read —

Interface settings Device

Tool information Erase Chip v || Erase now

Device information Fash {32 KB)

Osaillator Calibration

Memaries 4! Erase device before programming

Tmegal2BP8_Xpisined_Mind07_Firmware\shipment_firmware\medba_images-2.0.0.38\medbghex * | .

I

(=] ok

Pn | [ Read..
[ roce U} Verity Fash afie programming [ Progam | [ venty | [ Read |
Lock bits EEPROM (1 KB)
) CAUsersitbjoernvold\Documents\svmATSAMD10_Xplained_Min\ATSAMD10-XMINOT Firmwarel + |
Production file =
7! Verify EEPROM ahter programming | Program | | Vesty | | Resd.. |

Atmel ATmega328P Xplained Mini [USER GUIDE]
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5. Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program". Recommended
fuse settings:

e oo mwm =

l Tool Device Interface: Tl!gﬁ\’nlhg: l
|Jltmal—lCE -| ATmega2U4 |JTA.G -||.mpply Mm_ia? |Rud 50V |Read Lal
Interface settings Fuse Name Value
Tool information 0 BODLEVEL [ 2V0 =

¥ HWEBE Fll
Device information
) OCDEN
| Oscillator Calibration il
o ITAGEN el
Memaries ~

| @ seren 7
Fuses

| ¥ WDTON
Lock bits

(90 EESAVE il
Production file @eootsz  [2048w.3800 7

¥ BOOTRST
o CKDIVE el

EXTENDED (wF6 &

HIGH 81
Low 0x1E
Copy to clipboard
& Auto read e -
¥ Verify after programming | Program | Wenfy | Fesd
| = | Read registers..OK

1.4.5. Programming the ATmega32U4 Using a Bootloader
This section describes how to use the bootloader to program the ATmega32U4.

1. Install the Bootloader interface on the PC, download the installer from FLIP.

2. Start the Bootloader PC GUI "FLIP".

3. Short strap J102.

4. Connect the ATmega328P Xplained Mini board USB connector to the PC.

5. Select Device = ATmega32U4 (Device - Select).

6. Select USB communication (Ctrl+U).

7. Select memory area to program (use the toggle memory button bellow the Atmel logo).
8. Select Load Hex file (Ctrl+L).

9. Select Programming Options.

10. Click "Run", observe status in status field.

1.5. Board Assembly

The Xplained Mini board can easily be assembled into a product prototype for software development and
hardware verification.

1.5.1. Custom Assembly
All signals of the ATmega328P are available in the Xplained Mini board connector grid, enabling easy
connection of external sensors and output devices in order to prototype the customer specific application.

1.5.2. Standalone Node
The ATmega328P Xplained Mini board can be used as a standalone node with an external power source,
e.g. the 4xAAA or 2xAAA battery pack available from Atmel.

1.5.3.  Connecting an Arduino Shield
Arduino® shields can be mounted in the marked positions (J200, J201, J202, and J203).

AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 7
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1.6.2.

1.6.3.

mEDBG Command Line Interface

The mEDBG has a command line interface enabling configuration of the mEDBG.

mEDBG Low Power Modes

There are two modes enabling the Xplained Mini to save power when connected to an external power
source other than an USB connection.

Sleep Mode where the mEDBG is disabled. When enabled the ATmega32U4 will enter sleep mode if not
enumerated within about 5sec. In this mode the external clock is not available to the target MCU.

1MHz Mode where the mEDBG/ATmega32U4 is set to run at 1MHz, saving power while maintaining the
USB connection for the COM port. The external clock will be 1MHz.

Table 1-1 Available Commands

m External CLK |COM port mEDBG program | mEDBG debug

Sleep OxFB (bit2=0) | disabled disabled disabled disabled
1MHz OxFD (bit1=0) 1MHz enabled useless useless

Factory settings  OxFF 16MHz (@5V) | enabled enabled enabled
8MHz (@3.3V)

mEDBG Fuse Filter

The mEDBG does not initially allow users to program the CLK related fuses in the target. This is done to
avoid problems with the debugger when the target and mEDBG is not in CLK sync. This filter can be
disabled by issuing the command OxFE (bit0 = 0) enabling configuration of all ATmega328P fuses.

How to Issue Commands
The command line interface is supported by mEDBG version 1.6 or later.

The mEDBG command line interface can be accessed with the Python® script found on Atmel Spaces
Releases (MEDBG_script.zip).

If you have Studio 7.0 (and later versions), the mEDBG included supports the command line interface, if
not, the mEDBG can be downloaded from Atmel Spaces Releases (medbg_fw.zip).

Basic Python is required to run the script, Python can be downloaded from Python.
How to Issue Commands

Install Python.

Download the file "mEDBG_script.zip" from Atmel Spaces Releases.
Unzip the file "mEDBG_script.zip".

Edit "stuff.py" to issue the selected command "c.set_suffer(0xXX)".

Open a command window in the directory where "stuff.py" is located. (Browse to the, folder right-
click on folder with shift pressed and select “Open command window here”.)

Connect the Xplained Mini.

Run "stuff.py" (c:\Python27\python stuff.py).

The script will print the selected tool and display SUFFER setting.

Recycle power (disconnect/connect the board) for the change to take effect.

0. Edit "stuff.py" to issue the command c.set_suffer(OxFF) to reset to factory setting.

ok 0N~

—‘“3.0".\‘.@
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-

| A
B CA\Windowssystem32Ziemd exe l | =h= |—?&-J

CisllzerssthjoernuoldsDocumentssmEDBG_script >c is\Puthon2'™python stuff.py
CHSI5-DAP DLL loaded
CHSIS-DAP tools detected: 1
ool B>
Serial number: ATHML252301820000060083
Uendor: Atmel
Product: mEDBG CHMSIS-DAP
Device: Atmel ATmegad28PB
Packet size: b4

Selected mEDBG {ATHL2523818280806606863 >
Connected

Starting session...

SUFFER reads as: Bx«FB

UFFER reads as: BxFF

Ending session...

MSIS DLL freed

slzerssthjoernuo ldxDocumentssmEDBG_script >

How to Upgrade the Xplained Mini mEDBG

Start Atmel Studio.
Connect the Xplained Mini to the computer.
In Atmel Studio, select Tools — Device programming (Ctrl — Shift — P).

In the Device Programming window, select Tool to mEDBG and click Apply. If there is a new
mEDBG version available, the Atmel Studio will ask if you want to upgrade.

5. To verify mEDBG version, click "Tool Information" when mEDBG is selected as Tool.

-

Pob=

mEDBG (ATML2523010200000003) @ - Device Programiming

|| Tool Device Interface Device signature Target Vol
|mEDBG = | ATmega328PB = [ISP = | Apply| - | Read |
Interface settings mEDEG
Tool information i Debug host
Device information Ehug port

i

| Oscillator Calibration Sernial number ATMLZ523010200000003
Mirnories Connection com.atmel.avrdbg.connection.cmsis-dap
Frices Firmware Version la
bock bits Hardware Version 0

AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 9

Atmel-42287D-atmega328p-xplained-mini_User Guide-10/2015



2.

2.1.

2.2,

2.21.

Hardware User Guide

Board Overview
The ATmega328P Xplained Mini headers overview.

J301, Target power
J300, Power source J100, JTAG
J104, COM

J102, BOOT strap
mEDBG LED
External Clock
J202, power I/O

J200, Digital 1/0O high

J203, analogue |/O
J204, SPI

User button

User LED

J201, Digital I/0 low

Target Headers and Connectors
The ATmega328P related headers.

Target Digital 1/0
The J200 and J201 headers provide access to the ATmega328P digital I/O pins.

Table 2-1 J200 Digital /0 High Byte Header

12000 | ATmogaizsP i Faneton
1 PBO

PB1

PB2 SS, SPI Bus Master Slave select

PB3 MOSI, SPI Bus Master Output/Slave Input

PB4 MISO, SPI Bus Master Input/Slave Output

PB5 SCK, SPI Bus Master Clock Input

GND

AREF

o N oo o~ W DN

AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 10
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9

10

PC4

PC5

SDA, 2-wire Serial Bus Data Input/Output Line. Shared with
ADCA4.

SCL, 2-wire Serial Bus Clock Line. Shared with ADC5.

Table 2-2 J201 Digital /0 High Low Header

1

o N o o b~ W DN

PDO
PD1
PD2
PD3
PD4
PD5
PD6
PD7

2.2.2. Board Power Header
The J202 header enables connection to the ATmega328P Xplained Mini power system.

Table 2-3 J202 Power Header

1
2

o N o o b

NC
VCC_TARGET
RESET_SENSE

VCC_P3V3
VCC_P5V0
GND

GND
VCC_VIN

2.2.3. Target Analog I/O
The ATmega328P ADC input pins are available in the J203 header.

AREEF is available in J200 pin 8.

Atmel

TXD (ATmega328P USART Output Pin)
RXD (ATmega328P USART Input Pin)

The power source selected for the target (Select by J301)

This is a RESET signal monitored by the mEDBG, if pulled low the
target RESET line will be pulled low by the mEDBG. The ATmega32U4
internal pull-up is enabled. This signal is not available during debugging.

The 3.3V regulator output
The selected power source (VIN or VBUS selected by J300)

The external power source connection

Atmel ATmega328P Xplained Mini [USER GUIDE] 1"
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Table 2-4 J203 Analog Header

1 PCO ADC Input Channel 0
2 PC1 ADC Input Channel 1
3 PC2 ADC Input Channel 2
4 PC3 ADC Input Channel 3
5 PC4 ADC Input Channel 4
6 PC5 ADC Input Channel 5
2.2.4. Target Programming
The J204 header enable direct connection to the ISP bus with an external programmer for programming
of the ATmega328P.
Table 2-5 ISP Header
T T
1 PB4 MISO
2 VCC target
3 PB5 SCK
4 PB3 MOSI
5 PC6 RESET
6 GND
2.2.,5. Target Additional I/O
Signals not available in any of the headers or connectors, are available in column 5 of the grid.
Table 2-6 Additional I/O
ADC6 H5
ADC7 G5
2.3. Target GUI
The ATmega328P Xplained Mini has One LED and one push button.
i-o © © 0o ==mw © Q-0 o-o-ooé
solm ._ ] alo:
¥
SW200 D200
2.31. Push Button
A general purpose push button, SW200, is connected to PB7.
AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 12
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USER BUTTON

VCC_TARGET

L= a)
g
PB7 -
imJ:
(=)
4]
z
£ <4
ol pr
=
77}

—
"

—(C204
100n

GND

2.3.2. User LED
There is one yellow LED, D200, available for use by the application SW.

The LED is connected to ATmega328P pin 17 - PB5, the SCK signal from the mEDBG is in 3-state when
not used.

USER LED

PBS

R200
{11

D200
LED_12
\,\.ELl?-zluYCfAs

24. On-board Power Supply

The ATmega328P Xplained Mini board has an on-board 3.3V regulator (150mA), which can be used to
power the ATmega328P.

The J300 and J301 headers configure the ATmega328P power supply and the board power source.

AtmeL Atmel ATmega328P Xplained Mini [USER GUIDE] 13
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The default configuration is set by R300 and R301 0Q) resistors, which can be easily removed to change
the default configuration.

Table 2-7 Board Power Options

J301 connection, J300 connection,
target board

5V (Default) pin2 connected to pin1 | pin2 connected to pin1 | Board and target powered by VBUS

3.3V USB pin2 connected to pin2 connected to pin1  Target powered by 3.3V and USB
pin3, remove R301 interface powered by VBUS
VIN pin2 connected to pin1 | pin2 connected to pin3, Board and target powered by VIN
remove R300 (J202.8). 1.8V < VIN < 5.5V
3.3V VIN pin2 connected to pin2 connected to pin3, Target powered by 3.3V. VIN (J202.8)
pin3, remove R301 remove R300 as regulator input. 4V < VIN < 16V

Tip: Use the BOD LEVEL fuse to avoid the following challenges:
For the CPU to successfully decode and execute instructions, the supplied voltage must always
stay above the minimum voltage level set by the chosen operating frequency.

When supplied voltage drops below this level, the CPU may start to execute some instructions
incorrectly. The result is unexpected activity on the internal data and control lines.

This activity may cause CPU Registers, I/O Registers, and Data Memories to get corrupted.

To avoid these problems, the CPU should be prevented from executing code during periods of
insufficient supply voltage.

2.5. mEDBG

The ATmega328P Xplained Mini board has an embedded debugger/programmer enabling debugging and
programming of the ATmega328P without any additional external equipment.

2.51. mEDBG Status LED

The mEDBG has a green status LED connected to ATmega32U4 PC6 to signal the embedded debugger
state.

Table 2-8 mEDBG Green Status LED Function

Enumeration ON During the initial USB connection process the LED is on until enumerated
or if not enumerated it is turned off within about 5 seconds

Programming ON The LED is active during programming
Debugging ON The LED is active when the debugger is running
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2.5.2. mEDBG External Clock
The mEDBG (ATmega32U4) clock out signal (PC7) is connected to the ATmega328P external clock input
signal and can be used as the system clock source. The External Clock frequency is 16MHz when the
target is running at 5V and 8MHz when running at 3.3V.
‘ Tip: The External Clock can be set to 1MHz to save power using the mEDBG command line
. interface.
% Tip: There is a test point marked EXT.CLK enabling easy measuring and/or connection to the
Y CLK signal.
2.5.3. mEDBG COM Port Connection
The mEDBG provide a CDC COM port connection when connected to a USB host device.
The mEDBG (ATmega32U4) USART is used for communication with the CDC COM port. The USART
TX/RX signals are available on the J104 header and are also connected to the ATmega328P via 0Q
resistors enabling easy disconnect from the ATmega328P if needed.
Table 2-9 J104 USART Header
1-USART TxD PD3 TxD out from ATmega32U4
2 - USART RxD PD2 PDO RxD in to ATmega32U4
2.54. mEDBG JTAG Interface
The mEDBG (ATmega32U4) JTAG interface is available for programming and debugging of the
ATmega32U4.
Table 2-10 J100 JTAG Header
1 TCK
2 GND
3 TDO
4 VCC_BOARD ATmega32U4 V¢
5 TMS
6 RESET Connected to ATmega32U4 only
7 NC
8 NC
9 TDI
10 GND
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2.5.5.

mEDBG USB Interface
J101 is a Micro-B USB connector connected to the embedded debugger (ATmega32U4).

Table 2-11 J101 USB Header

1 VBUS
2 D-

3 D+

4 NC

5 GND

The VBUS has a resettable PTC fuse (F100), with a hold current of 0.5A and a trip current of 1.0A to
protect the USB host device.

2.6. Extension Header Area
The marked area on the grid I7 to R8 can be used for strapping in an Xplained Pro extension header or a
10-pin Xplained/RZ600 header.
Extension header area
SPI_SS
SPI_MISO
The SPI bus signals are made available close to the header at row J and K, enabling easy connection to
header pin 15 to 18.
Using Pin 11 to 20 enables connection of the 10-pin connector used on the RZ600 wireless modules and
the 10-pin Xplained sensor modules.
The general bus connections for an Xplained PRO Extension board is indicated in the table below,
detailed wiring can be found in the selected extension board documentation.
Table 2-12 Extension Header Typical Signals
1 ID Communication line to the ID chip on the Xplained extension board
2 GND Ground
3 ADC(+) Analog to digital converter, alternatively positive part of differential ADC
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2.7.

4 ADC(-) Analog to digital converter, alternatively negative part of differential ADC
5 GPIO1 General purpose I/0
6 GPIO2 General purpose I/0
7 PWM(+) Pulse width modulation, alternatively positive part of differential PWM
8 PWM(-) Pulse width modulation, alternatively negative part of differential PWM
9 IRQ/GPIO Interrupt request line and/or general purpose 1/0
10 SPI_SS B/ Slave B select for SPI and/or general purpose /O
GPIO
11 12C_SDA Data line for I12C interface
12 12C_SCL Clock line for 12C interface
13 UART_RX Receiver line of ATmega328P USART
14 UART_TX Transmitter line of ATmega328P USART
15 SPI_SS A Slave A select for SPI
16 SPI_MOSI Master out slave in line of serial peripheral interface
17 SPI_MISO Master in slave out line of serial peripheral interface
18 SPI_SCK Clock for serial peripheral interface
19 GND Ground
20 VCC Power for extension board

Factory Programmed

The ATmega328P is preprogrammed with a demo program, ReMorse.
Source code is available in Atmel Spaces.

When the CDC COM port is connected to a terminal window (9600 N81), the text you write will be
transmitted via the LED in Morse code. Any Morse code transmitted by using the switch will be displayed
as text in the terminal window.

The ATmega32U4 is preprogrammed with the mEDBG.
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http://spaces.atmel.com/gf/project/avr_xp_mini/

3. Document Revision History

Document revision Date Comment

42287D 10/2015 In Section 1.4, programming: SPI

has been changed to ISP.

42287C 08/2015 Updated version

42287B 10/2014 Updated version

42287A 05/2014 Initial document release
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